MeetingCentre™

Integration with Outlook Guide

InterCall, a subsidiary of West Corporation, in partnership with WebEx Communications,
Inc., provides MeetingCentre web conferencing services. Because MeetingCentre is
powered by WebExmw, this guide makes several references to the company name,

“ |nterCa| | platform and features.

Integration with Outlook

0871 7000 170 L R o
+44 (0)1452 546742 Integration with Outlook provides a convenient way for you to schedule, start or join

conferencing@intercalleurope.com online meetings using Microsoft Outlook. Using Integration with Outlook, you can
perform these activities without the need to use the MeetingCentre website.

Information Hotline

Reservations
0870 043 4167 Integration with Outlook is a plug-in program for Microsoft Outlook, which you download
S Viiase vaedhe from the MeetingCentre website and then install on your computer. Once you install
resv@intercalleurope.com ; ] ; ) - .

Integration with Outlook, new options appear in Outlook allowing you to quickly schedule

www.intercalleurope.com an online meeting.

When scheduling a meeting, you can invite attendees using any of your Outlook address
lists, including the Global Address List, Personal Address List or Contacts folder.
Attendees whom you invite to a meeting need not use Integration with Outlook to join the
meeting.

Integration with Outlook also provides:

+ Quick access to My WebEx on the MeetingCentre website, which includes your
personal list of meetings, user profile and other account.

+ Quick access to the One-Click Meeting Wizard on your MeetingCentre website,
with which you can set up an instant meeting that you, can start at any time, as
often as you want.

+ A template for meeting invitations, which you can modify with any information you
want to provide security for your meetings, Integration with Outlook uses 128-bit
SSL (Secure Sockets Layer) encryption for all data it sends to and retrieves from
the MeetingCentre website.

+ To provide security for your meetings, Integration with Outlook uses 128-bit SSL
(Secure Sockets Layer) encryption for all data it sends to and retrieves from the
MeetingCentre website.

System Requirements

Before installing Integration with Outlook, ensure that your computer meets the following
system requirements.
-+ Windows 98, 2000, ME, XP, or NT

+ Intel x86 (Pentium 400 MHZ+) or compatible processor

+ Microsoft Internet Explorer 5, 6, Mozilla 1.6 or later, or Netscape 4.7, 7.x
+ JavaScript and cookies enabled for the browser

+ 56K or faster Internet connection

+ Microsoft Outlook 2000 or later

st InterCall is &
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INSTALLING INTEGRATION WITH OUTLOOK

To install Integration with Outlook on your computer, you must first download the Setup program from the MeetingCentre
website at www.MeetingCentre.net. Before installing Integration with Outlook, ensure that your computer is connected to the
Internet and have the following information handy:

+ The web address or URL

For the MeetingCentre website (Please note: For per minute site users, use the following URL: https://intercall.webex.com.
For branded site users, use your custom URL, i.e. http://companyname.webex.com).
+ Your MeetingCentre user name and password

To Install Integration with Outlook:

Quit Microsoft Outlook if it is running on your computer.

Go to the MeetingCentre website at www.meetingcentre.net.
Click on Resource Centre.

Click on the Outlook Plug-in.

Save the Setup program to your computer.

Run the Setup program by doing either of the following:

a. Inthe Download Complete dialog box, click Open.

b. Double-click the Setup program, which has the file name olkint.msi.
Follow the instructions in the Setup program.

Once installation is complete, start Microsoft Outlook.

D OB W N

About Integration with Qutlook Options
Once you install Integration with Outlook, the following new items appear in Microsoft Outlook:
ToolBar

New options appear on the Outlook toolbar.

@ One Click Mesting :ﬂ Schedule Meeting ‘WebEx =

The following table describes the toolbar buttons:

Button Description

Schedule Meeting Opens the Outlook Meeting window, which now contains Integration with Outlook
options for scheduling an online meeting.

One-Click Meeting Opens the One-Click Meeting Wizard on the MeetingCentre website, with which

you can set up a One-Click Meeting. A One-Click Meeting is an instant meeting
that you can start at any time, as often as you want, by clicking a shortcut on your
computer.

WebEx Opens a menu on which you can: Access your MyWebEx area on the
MeetingCentre website. Specify your user account information, that is — the URL
of your MeetingCentre website and your user name and password. Open the
template for meeting invitations and customise the template for your needs.
Check for updates to Integration with Outlook
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WEBEX TAB
A new WebEXx tab appears in the Meeting and Appointment windows for your Outlook calendar, as follows:
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SPECIFYING YOUR WEBEX ACCOUNT SETTINGS

To schedule an online meeting in Outlook or use the One-Click Meeting feature, you must specify your WebEx account
information.

To specify Account Information:

1 1 Inthe Microsoft Outlook, on the toolbar, click WebEx.
2 Onthe menu that appears, choose Account Settings. The WebEx Account Settings dialog box appears.

Webk Account Scttings x|

Wty site adoress: |

Password: | JEFIT - |

W Remeamber my Lser name and password

x| cacel |

3 Inthe WebEXx site address text box, enter the URL for your MeetingCentre website.

In the User name text box, enter your MeetingCentre user name.
In the Password text box, enter your MeetingCentre password.
Optional. Click Verify to ensure that your account information is correct.

Optional. To let Outlook log you into MeetingCentre automatically when you schedule a meeting, select the
Remember my user name and password check box.

8 Click OK to save your account settings.
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SCHEDULING A MEETING
Before scheduling an online meeting using Integration with Outlook, be aware of the following:

+ Integration with Outlook provides basic options for scheduling a meeting. Thus, some options that appear in the
Schedule a Meeting Wizard on the MeetingCentre website are not available in Integration with Outlook.

+ Integration with Outlook does not support all of the recurrence options that are available in Outlook.

+ In any meeting invitations that you send via Outlook, the meeting’s starting time appears in the time zone that is set on
your computer, not in your site preferences for MeetingCentre.

+ On the MeetingCentre website, all meeting times appear in the time zone that you set in your site preferences,
regardless of the time zone that is set on your computer.

+ For Integration with Outlook, to schedule a meeting on the MeetingCentre website, your computer must be connected
to the Internet. Otherwise, Integration with Outlook saves the scheduled meeting in your Outlook Outbox and
automatically schedules the meeting on your site the next time your computer connects to the Internet.

SETTING UP A SCHEDULED MEETING

To schedule a meeting using Integration with Outlook, you simply open a new meeting request or appointment in Outlook
and then specify information about the meeting, as follows:

Start a new meeting request in Outlook:
1 1 Ensure that your computer is connected to the Internet.

2 Do either of the following:
a. Click Schedule Meeting on the toolbar.

Zi] Schedule Mesting
b. On the File menu, point to New and then click Meeting Request.
ety predee SR

W T s m———

| — -

The Outlook Meeting window appears.
Specify general meeting information:

1 1 Inthe Outlook Meeting window, type a topic for the meeting in the Subject box.

2 Inthe Start time and End time drop-down lists, specify the starting and ending times for the meeting,
respectively.

3 Optional — To specify a recurrence pattern for your meeting, click Recurrence and then select recurrence
options
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Invite attendees to the meeting:
1 Click the Attendee Availability tab.
2 Specify attendees who you want to invite to the meeting

Provide your account information:
1  Click the WebEx tab. The login panel appears.
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2 Provide your MeetingCentre account information

3 Optional — To automatically log into MeetingCentre whenever you schedule a meeting using Integration with
Outlook, click the Remember user name and password check box.

Specify general meeting information:
1 1 Click Meeting Type and select MeetingCentre. The Meeting Type panel appears.

2 Select the Online Meeting check box.
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In the Use Meeting Type drop-down menu, select Pro Meeting or Pro+MPV (Multipoint Video)

Specify whether the meeting appears on the meeting calendar on your MeetingCentre branded website or if it
is unlisted. (Available only on branded MeetingCentre sites.)

5 Specify tracking codes, if tracking codes are set up. NOTE: MeetingCentre per minute users do not utilise
tracking codes.



@) InterCall

Specify a Meeting Password:

1

2
3
4

Click Password. The Password panel appears.
Specify a password, if applicable, for the meeting in the Meeting Password box.
Type the password again, if applicable, in the Confirm Password box.

Optional — To prevent the meeting password from appearing in the invitation email messages that attendees
receive, select the Exclude meeting password from email invitations check box.
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Setup an InterCall audio conference for the meeting:

1
2
3

Click Teleconference. The Teleconference panel appears.
Click the Teleconference drop-down menu. Select either None or Other Teleconference.

If you select Other Teleconference, enter your InterCall audio conference Dial-In Number(s) and Conference
Code (if applicable).
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Specify attendee information:

1
2

Click Attendee Information. The Attendee Information panel appears.

Optional — If you require attendees to register for the meeting, select the Require Attendee Registration check
box.

Optional — If you require registration, avoid having to manually accept registration requests by selecting the
Automatically accept all registration requests check box.

Optional — If you will allow attendees to join the meeting before you start it, select the Allow attendees to join
the meeting before host check box and then select a number of minutes in the box.
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Specify meeting options:
1 1 Click Meeting Options. The Meeting Options panel appears.

2 Optional — Choose a template for the Info tab, which appears in the content viewer once you start the meeting.

3 Optional — To specify a file that you want to open automatically in each attendee’s Meeting window once he or
she joins the meeting, select the Auto-play presentation before the host joins the meeting check box and then
choosing a presentation file. If you select this check box, an Outlook security message may appear.

4 Optional — To allow another user to host the meeting for you, by selecting the Assign as Alternate Host check
box, and then selecting one or more names in the list box. If you select this check box, and Outlook security
message may appear.
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Send meeting invitations:

1 1 Once you have finished setting up the meeting, click Send. Integration with Outlook contacts the
MeetingCentre website and then adds the scheduled meeting to your Outlook calendar and to your list of
meetings on your website. A message then appears confirming that the meeting was scheduled on the
MeetingCentre website.

2 Click OK to close the confirmation message.

ABOUT SPECIFYING A RECURRANCE PATTERN FOR A MEETING

Using Outlook recurrence options, you can specify a recurrence pattern for your meeting. For example, you can specify that
a meeting recurs every Wednesday at 2:00 PM until a specific date. Integration with Outlook schedules the meeting on each
day that you specify in the recurrence pattern.

The recurrence options that you can use in Outlook are limited to the options that are available on the MeetingCentre
website. The following are the recurrence options in Outlook that MeetingCentre does not support:

+ Recur every [X] week(s) on [Monday/Tuesday/Wednesday/Thursday/Friday/Saturday/Sunday]. For this option, the
value of X must always be 1.

+ The [first/second/third/fourth/last] [day/weekday/weekend day] of every [X] month(s). For this option, you can select
only a specific day of the week, not day, weekday or weekend day.
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ABOUT THE MEETING TYPES PANEL

The Integration with Outlook Meeting Types panel contains the following options:

1 1 Online meeting — Specifies that you are hosting the meeting using MeetingCentre. You must select this option to
schedule the meeting on your MeetingCentre website.

2 Use meeting type — Available only if your site provides different meeting types (for example: Pro Meeting and
Pro+MPV). Each meeting type provides a different set of available options.

3 Unlisted meeting — Specifies that the scheduled meeting does not appear on the calendar on your MeetingCentre
website. An unlisted meeting prevents visitors to the site from viewing information about the meeting, such as its
host, topic and starting time, and helps to prevent unauthorised access to the meeting. To join an unlisted meeting,
an attendee must provide a unique meeting number.

4 If you invite an attendee to an unlisted meeting, the meeting invitation includes complete instructions for joining the
meeting — including the meeting number and a link to the web page in which the attendee can join the meeting.

5  Tracking codes — If your organisation uses tracking codes, options for your project, division, department and so on
appear in the panel. To specify tracking codes, do one of the following:
a. Ifalist of codes appears in the box on the right, select a code from the list.
b. Type a code in the box on the right.

ABOUT THE MEETING PASSWORD PANEL

On the Integration with Outlook Meeting Password panel, you can require that attendees provide a password to attend a
meeting. If you require a password, all participants must provide the password to attend the meeting. Thus, requiring a
password helps to secure a meeting from unauthorised access. If you invite a participant to a meeting that requires a
password, the participant receives an invitation email message that includes the password, unless you specify that
passwords do not appear in email invitations.

If you choose to exclude the password from email invitations, then you must provide the password to attendees by another
method — for example, by phone. To exclude the password from the invitation, on the WebEXx tab, select the Exclude
password from email invitation check box.

ABOUT THE TELECONFERENCE PANEL
The Integration with Outlook Teleconference panel contains the following options:

+ None — The meeting does not include an audio conference.

+ Other Teleconference — If you select this option, you can provide the instructions for joining your InterCall audio
conference call. The instructions will appear in the meeting invitations that you send to attendees.

USING AUDIO CONFERENCING OPTIONS
Once you schedule a meeting, instructions for joining the audio conference automatically appear:

+ On the Meeting Information page on your site, which participants can view before you start the meeting
+ In invitation email messages, if you invite participants using Outlook
+ In the Join Teleconference dialog box, which appears in participants’ meeting windows once they join the meeting.
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ABOUT THE ATTENDEE INFORMATION PANEL
The Integration with Outlook Attendee Information panel contains the following options:

+ Require attendee registration: Specifies that all attendees must register to attend the meeting. An attendee cannot
attend the meeting until you accept his or her registration request. To register for a meeting, attendees must provide
the following information:

+ First name
+ Last name
+ Email address

+ Automatically accept all registration requests: Accepts all registration requests automatically and lets all registrants
attend the meeting. You do not receive registration requests. If this option is not selected, you must accept or reject
each registration request individually using the options on the MeetingCentre website.

+ Allow attendees to join meeting before host: Specifies that participants can join the meeting a specified number of
minutes before the meeting’s scheduled start time.

+ Attendees can join [x] minutes before meeting starts: Specifies the number of minutes before a meeting’s scheduled
start time that attendees can join the meeting.

ABOUT THE MEETING OPTIONS PANEL
The Integration with Outlook Meeting Options panel contains the following options:

+ Template: Lets you choose a template for the Info tab, which appears in the content viewer during the meeting. The
Info tab contains information about the meeting, including the host, audio conference phone numbers and host key (if
you are the host). You can choose another template only if your site administrator has provided one or more
customised Info tab templates for MeetingCentre. (available only for branded Meeting Centre sites)

+ Auto-play presentation before host joins the meeting: Specifies that a presentation or document that you select is
shared automatically for participants who join the meeting before you start it. The presentation appears in each
participant’s content viewer once he or she joins the meeting. If the presentation has multiple slides or pages, they
advance automatically every twenty seconds. The file that you select must:

+ Be in the WebEXx Universal Communications Format (UCF).

+ Reside in your personal folders (My Files) on the MeetingCentre website. You can select a UCF file that already
resides in your folders or you can upload a new file to your folders and then select it while schedule a meeting.

+ Upload: Opens the Add/Select Presentation page on the MeetingCentre website on which you can select a
presentation or document that resides in your personal folders or upload a new file to your folders.

+ Assign as alternate host: Lets you designate one or more attendees as alternate hosts for the meeting. An
alternate host can start the meeting and act as the host. Thus, an alternate host must have a user account on
your MeetingCentre website.
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If you select this check box, the Microsoft Outlook security message shown to the left may appear, depending on your
organisation’s Outlook Exchange Server security policies. In this case, the security warning appears because you are
attempting to access your organisation’s Outlook contacts database.

Do either of the following:

+ Click Yes. Depending on how many attendees you have invited, you may need to click Yes several times to close the
warning message.

+ Click Allow access for, and then select a number of minutes. Usually, 1 minute is sufficient for Outlook Integration to
retrieve the list of invited attendees. Then click Yes.

Once you select the check box, the list box shows all invited attendees. Select from the attendees in the list those you would
like to be alternate hosts. To select multiple attendees, hold down your keyboard’s Ctrl key.

Once you invite an attendee to a meeting as an alternate host, the attendee receives an invitation email message that
provides information about acting as the alternate host. Your scheduled meeting appears on the alternate host's My WebEx
Meetings page on your MeetingCentre website.

If you join the meeting after an alternate host has started or joined it you do not automatically assume the host role.

However, the alternate host can designate you as the host upon your arrival.

ADDING INFORMATION TO YOUR MEETING

If you invited attendees to your meeting, you can add information to the meeting invitation that they receive before you send
it. For example, you can provide additional information about the meeting that Integration with Outlook does not automatically
provide for you, such as an agenda, information about the presenters and so on. Any text that you add automatically appears
on the Agenda page for the meeting on the MeetingCentre website.

To add information to your meeting invitation:

1 1 Once you have finished setting up a meeting and inviting attendees, choose Save in the Outlook Meeting
window on the File menu. Integration with Outlook contacts your MeetingCentre website and then adds the
scheduled meeting to your Outlook calendar and to your list of meetings on the MeetingCentre website. A
message then appears confirming that the meeting was scheduled on the MeetingCentre website.

2 Click OK to close the confirmation message. On the Appointment tab of your invitation, information about your
meeting automatically appears in the text box, such as the URL, the meeting password, if required and the
audio conference information.

3 Onthe Appointment tab, type any additional information about the meeting in the text box below the
information that automatically appears.

4 Click Send.
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MODIFYING A SCHEDULED MEETING

Once you schedule a meeting using Integration with Outlook, you can use Outlook to modify it at any time. For example, you
can change its starting time, specify a new password, change the audio conference number and so on. Once you modify a
scheduled meeting, Integration with Outlook sends an updated meeting invitation to any attendees whom you invited to the
meeting and updates the meeting information on the MeetingCentre website.

To modify a scheduled meeting:
1 1 On your Microsoft Outlook calendar, open the item for the scheduled meeting.
2 Modify the information and options on either the Appointment tab or WebEx tab.
3 Click Send Update.

Integration with Outlook contacts the MeetingCentre website and updates the meeting on the site. A message appears
confirming that your meeting was updated.

Starting A Meeting

Once you schedule a meeting using Integration with Outlook, you can start the meeting in either of the following ways:
+ On your Microsoft Outlook calendar, open the meeting item then click the link to start the meeting.
+ Log in to the MeetingCentre website and then start the meeting from your My WebEx Meetings page.
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CANCELLING A MEETING

You can cancel a meeting in Microsoft Outlook. All attendees whom you invited to the meeting automatically receive a
cancellation notice. If your computer is connected to the Internet, Integration with Outlook also contacts the MeetingCentre
website and cancels or removes the meeting from the site. A message appears confirming that your meeting was removed
from the MeetingCentre website. You also receive a cancellation notice in an email message.
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CUSTOMISING THE MEETING INVITATION TEMPLATE

Integration with Outlook provides a template for meeting invitations that you send to attendees. The information in the
template appears in the text area of the Microsoft Outlook invitation email messages, as follows:
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This template includes both default text and variables — codes that your meeting service recognises and substitutes with your
specific meeting information. You can customise this template by editing the default text, rearranging variables and removing
variables.

The default meeting invitation template provides the following variables:

<Host Name> Displays your full name, as it appears in your user profile on your web
conference website.

<Meeting Topic> Displays the topic for the meeting, as it appears in the Subject box in your
meeting invitation.

<Meeting Date> Displays the date on which the meeting occurs, as it appears in the Start Time
box in your meeting invitation.

<Meeting Number> Displays the unique number that your meeting service assigns to a meeting. For
an unlisted meeting, participants must provide the meeting number to attend the
meeting.

<Meeting Password> Displays the password for the meeting, as you specified it on the Meeting
password panel when scheduling the meeting.

<Teleconferencing Info> Displays information about how to join the audio conference for the meeting.

<Meeting Link> Displays the Web address, or URL, that attendees can click to join the meeting.

<Host Email> Displays your email address as it appears in your user profile on your web

conference website.

Once you customise the template, you can reset it to its default state at any time, regardless of whether you removed any
variables.
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TO CUSTOMISE THE MEETING INVITATION TEMPLATE:

1 In Microsoft Outlook, on the toolbar, click WebEXx.
2 Onthe menu that appears, choose Invitation Template. The Invitation Template window appears.
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3 Modify the message as necessary.
4 Click Update.

TO RESET THE MEETING INVITATION TEMPLATE TO ITS DEFAULT STATE:

1 In Microsoft Outlook, on the toolbar, click WebEx.

2 Onthe menu that appears, choose Invitation Template. The Invitation Template appears.
3 Click Reset.

Joining a Meeting

If a meeting host uses Integration with Outlook to invite you to a meeting, you receive an invitation email message that

includes a link that you can click to join the meeting. The invitation differs depending on whether or not you use Microsoft
Outlook.

JOINING A MEETING USING OUTLOOK

If you use Microsoft Outlook, you receive an invitation email message in your inbox. Once you accept the invitation, it
appears on your Outlook calendar.

To join the meeting, open the invitation on your calendar and then click the link to join the meeting.
The figure below shows an example of a meeting invitation in Outlook:
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CHECKING FOR UPDATES TO INTEGRATION WITH OUTLOOK

You can periodically check for updates to Integration with Outlook. If an update is available, Integration with Outlook asks
you whether or not you want to install the update.

To check for updates to Integration with Outlook:
1 If necessary, start Microsoft Outlook

2 On the Outlook toolbar, click WebEx.
3 On the menu that appears, choose Check for Update.

Removing the Outlook Plug-In
You can do either of the following:
+ Temporarily remove the WebEXx tab that appears in your Meeting and Appointment windows in Microsoft Outlook.

+ Remove, or uninstall, the Outlook plug-in from your computer

Temporarily Removing the WebEx Tab From Outlook:

If you selected the Integration with Outlook form to be your default Meeting and Appointment forms in Microsoft Outlook, a
WebEXx tab always appears in the Meeting and Appointment windows in Outlook. However, you can remove this tab at any
time without uninstalling the Outlook plug-in.

To remove the WebEXx tab, you must choose another form to be your default Meeting and Appointment form in Outlook. You
can switch between Integration with Outlook form and another form at any time.

To remove the WebEx tab from the Meeting and Appointment windows:
1 In Microsoft Outlook, in the folder list, right-click Calendar.

If the Folder List is not visible, choose Folder List on the View menu
On the menu that appears, choose Properties. The Calendar Properties dialog box appears.
Ensure that the General tab is selected.

In the When posting to this folder use drop-down list, select Appointment — which is the default form for
meetings and appointments in Outlook — or another form that your organisation uses.

6 Click OK. The WebEx tab no longer appears in the Meeting and Appointment windows in Outlook.
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Uninstalling Integration with Outlook
You can remove the Outlook plug-in from your computer at any time using either the Windows Add/Remove Programs utility
or the Setup program that you downloaded when installing the Outlook plug-in.

To uninstall Integration with Outlook:
1 1 Quit Microsoft Outlook.

2 Ensure that no Outlook processes are still running on your computer. To do so, you can reboot your computer
or you can terminate any running Outlook processes, as follows:

Press Ctrl+Alt+Delete on your computer’s keyboard.
Click Task Manager.
Click on the Processes tab
Select the OUTLOOK.EXE process.
. Click End Process.
3 Do either of the following:
a. Open the Windows Add/Remove Programs utility on your computer, select My WebEXx Integration with
Outlook and then select the option to remove the program.
b. Double-click the Integration with Outlook Setup program (olkint.msi) and then follow the instructions to
remove the program.
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